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Tropy - Photo et sélections


Tropy est un logiciel libre (open source) conçu pour organiser et gérer des collections d’images. Développé par la fondation Digital Scholar (qui développe aussi Zotero et Omeka), il est principalement utilisé dans le domaine de la recherche en sciences humaines et sociales (même s’il est aussi apprécié par les usager·ère·s plus grand public des services d’archives comme les généalogistes. (voir Valmalle, 2021)).
Il permet aux chercheur·es de classer, anoter, et organiser des photos et des documents numérisés, comme des archives ou des manuscrits, en vue de faciliter leur utilisation et leur éventuelle publication.
Principales fonctionalités :
· Création de projets pour organiser les images par collections et catégories (tags).
· Ajout de métadonnées détaillées à chaque objet (item), image et zone d’image (sélection).
· Possibilité d’associer des annotations aux images et aux sélections.
· Exportation des données sous forme de fichiers compatibles avec le web sémantique (format JSON-LD par défaut) ou avec d’autres logiciels (comme Zotero ou OmekaS avec les extensions dédiées).
Des métadonnées riches…
Dans la documentation de Tropy : What is metadata and how do I use it?
Que sont les métadonnées ?
Les métadonnées sont des données qui décrivent d’autres données. Elles fournissent des informations sur un fichier, un document, ou tout autre type de ressource numérique. Par exemple, pour une photo, les métadonnées peuvent inclure le titre, le nom du créateur, la date de création, le format, et les droits d’utilisation.
Les métadonnées aident à organiser, identifier et trouver facilement des informations en donnant des détails sur le contenu, la structure et le contexte des données (ici vos objets, images et sélections).
Qu’est-ce qu’un schémas de métadonnées ?
Un schéma de métadonnées est un ensemble structuré de règles et de propriétés utilisées pour décrire de manière cohérente des données ou des ressources. Il définit quelles informations (ou métadonnées) doivent être collectées, comme le titre, le créateur, la date, ou le type de ressource, ainsi que la manière de les organiser.
Un schéma de métadonnées est une structure standardisée qui aide à organiser et harmoniser les informations descriptives sur des fichiers ou documents, facilitant ainsi leur recherche et leur gestion.
Dans Tropy, des schémas de métadonnées comme les Dublin Core, Exif, ou Europeana Data Model (EDM) sont chargés par défaut. En fonction des besoins de votre projet et du type d’objets que vous décrivez, vous avez également la possibilité de personnaliser ou importer vos propres schémas selon des standards adaptés à vos recherches (comme CIDOC-CRM, VRA Core…).
Les schémas Dublin Core
[image: IMG/Dublin-Core.png]
Il existe deux schémas de métadonnées dits Dublin Core, tous deux disponibles par défaut dans Tropy : le Dublin Core Metadata Element Set et les Dublin Core Metadata Terms.
La différence entre les Dublin Core Elements et les Dublin Core Terms réside principalement dans leur étendue, leur structure, et leur niveau de formalisation.
Dublin Core Elements
Le Dublin Core Metadata Element Set (DCES) est un ensemble de 15 éléments de métadonnées de base, conçus pour être utilisés de manière générale pour décrire une large gamme de ressources numériques. Ces éléments sont simples et universels, ce qui les rend largement utilisables dans différents contextes.
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	Les 15 éléments Dublin Core Elements
1. Title (Titre)
1. Creator (Créateur)
1. Subject (Sujet)
1. Description
1. Publisher (Éditeur)
1. Contributor (Contributeur)
1. Date
1. Type
1. Format
1. Identifier (Identifiant)
1. Source
1. Language (Langue)
1. Relation (Relation avec d’autres ressources)
1. Coverage (Couverture géographique ou temporelle)
1. Rights (Droits)


Usage
Ces éléments sont conçus pour être simples et suffisamment génériques pour s’adapter à divers environnements de gestion de métadonnées, notamment les bibliothèques, les archives, et les musées. Ils ne nécessitent pas une grande complexité ou personnalisation, et peuvent être utilisés dans de nombreuses disciplines.
Objectif
Faciliter l’interopérabilité entre différents systèmes et rendre les ressources numériques facilement trouvables et accessibles. C’est l’ensemble de métadonnées de base recommandé pour les projets qui veulent une approche standard, mais simple.
Formalisation
Les Dublin Core Elements font partie des normes ISO et sont compatibles avec les pratiques d’interopérabilité sémantique sur le web.
Dublin Core Terms
Les Dublin Core Metadata Terms (DCTerms) est une extension du Dublin Core Elements. Il comprend non seulement les 15 éléments de base, mais aussi un ensemble beaucoup plus vaste de termes supplémentaires, incluant des sous-éléments, des éléments de qualification (qualifiers), et des concepts plus précis qui permettent d’enrichir la description des ressources.
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	Structure étendue des DCMT
Les Dublin Core Terms incluent :
· Les 15 éléments de base (mais sous des formes plus formalisées).
· Des éléments supplémentaires comme Audience (Public), Provenance (Provenance), Accrual Method (Méthode d’acquisition), etc.
· Des qualificateurs qui permettent de préciser davantage un élément existant. Par exemple, la date peut être qualifiée avec des sous-éléments comme Date.Created (date de création), Date.Modified (date de modification).


Usage
Les Dublin Core Terms sont utilisés dans des contextes plus complexes ou spécialisés où il est nécessaire d’étendre la description des métadonnées au-delà des 15 éléments de base. Cela permet d’adapter les métadonnées à des besoins spécifiques, comme dans les bibliothèques numériques avancées, les archives, ou des bases de données nécessitant une structure riche.
Objectif
Fournir une structure plus flexible et plus riche pour décrire des ressources en utilisant des éléments plus détaillés. Il permet de mieux correspondre aux besoins spécifiques des projets tout en restant compatible avec les standards du web sémantique.
Formalisation
Les Dublin Core Terms sont également formalisés selon des standards internationaux et sont souvent exprimés en RDF (Resource Description Framework) pour une meilleure compatibilité avec le web sémantique.
Principales différences entre Dublin Core Elements et Dublin Core Terms
Comparaison DCES et DCTerms
	Critères
	Dublin Core Elements (DCES)
	Dublin Core Terms (DCTerms)

	Nombre d’éléments
	15 éléments de base
	Comprend les 15 éléments + des termes étendus et qualificateurs

	Simplicité
	Simple, général
	Plus complexe, flexible et spécifique

	Utilisation
	Projets de description de ressources de base
	Projets nécessitant des métadonnées plus riches et complexes

	Interopérabilité
	Conçu pour des utilisations larges et génériques
	Plus détaillé, mais compatible avec des systèmes plus complexes

	Qualification des éléments
	Pas de qualificateurs
	Supporte des qualificateurs pour une meilleure précision

	Exemples d’utilisation
	Bibliothèques, archives numériques simples
	Bibliothèques numériques avancées, projets sémantiques, bases de données spécialisées
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	Synthèse Dublin Core
· Dublin Core Elements est idéal pour une description simple et universelle de ressources numériques, facilitant une adoption rapide et large dans des environnements variés.
· Dublin Core Terms fournit un cadre plus élaboré, utile pour des projets nécessitant une description plus fine et spécialisée, avec une interopérabilité accrue dans des environnements complexes comme le web sémantique.


Le schéma Europeana Data Model (EDM)
Europeana Data Model est un schéma utilisé par Europeana [footnoteRef:61] pour décrire des objets culturels numériques en accord avec les standards du web sémantique. [61:  Europeana est un portail européen qui présente des ressources patrimoniales provenant de quelque 2000 institutions différentes. Un réseau de partenaires agrégateurs se charge de collecter les données, de les vérifier minutieusement et de les enrichir d’informations telles que la géolocalisation, ou de les relier à d’autres données ou ensembles de données par le biais de personnes, de lieux ou de thèmes associés. (Liste des partenaires agrégateurs, dont Gallica)] 

Caractéristiques clés :
· Modèle RDF : EDM est basé sur le Resource Description Framework (RDF), un standard du W3C utilisé pour représenter des informations sur des ressources dans le web sémantique. Cela permet de relier des objets à d’autres ressources, qu’elles soient internes ou externes à Europeana.
· Séparation des différentes entités : EDM distingue clairement plusieurs types d’entités, ce qui permet de modéliser les relations complexes entre les objets numériques et leur contexte. Parmi ces entités, on trouve :
· ProvidedCHO (Cultural Heritage Object) : représente l’objet culturel lui-même (par exemple, une peinture, un manuscrit).
· WebResource : fait référence aux versions numériques de l’objet, telles que les fichiers d’image, vidéo ou son.
· Aggregation : permet de regrouper les données sur un objet, notamment les métadonnées des différentes sources.
· Agent : représente les entités ayant une influence sur l’objet (par exemple, un auteur, un artiste, un contributeur).
· Place et TimeSpan : permettent de contextualiser l’objet dans le temps et l’espace.
· Multi-représentation : EDM permet d’avoir plusieurs représentations numériques d’un même objet culturel (images de différents angles, fichiers audio associés, etc.), ainsi que des relations entre ces différentes représentations.
· Alignement avec d’autres standards : EDM est conçu pour être interopérable avec d’autres schémas de métadonnées, notamment Dublin Core, LIDO (utilisé dans les musées), EAD (Description archivistique encodée), et OAI-PMH (Open Archives Initiative Protocol for Metadata Harvesting).
Les proriétés Exchangeable Image File Format (EXIF)
EXIF est un ensemble de propriétés techniques centré sur les conditions de création des fichiers visuels. Contrairement au Dublin Core, il ne vise pas à fournir une description sémantique mais plutôt une description technique du fichier lui-même.
EXIF est un standard de métadonnées techniques utilisé principalement dans les fichiers d’image (JPEG, TIFF) et les fichiers vidéo pour enregistrer des informations relatives aux conditions dans lesquelles l’image ou la vidéo a été capturée. Cela inclut des données techniques comme les paramètres de l’appareil photo (modèle, vitesse d’obturation, ouverture, ISO, orientation), la date et l’heure, des informations géographiques (si le GPS est activé) ainsi que des informations sur le fichier (taille, résolution).
La page Wikipedia Exchangeable image file format donne un exemple concret et la liste des principales métadonnées EXIF.
Ces propriétés sont enregistrées dans le fichier numérique lui-même. Dans Tropy, on ajoutera des propriétés EXIF dans des modèles de niveau photo, pour “sortir” automatiquement ces informations du fichier.
Tropy extrait automatiquement les données suivantes pour chaque photo :
· Le nom du fichier
· La date de création
· la taille de l’image en pixels (800X1200)
· la taille de l’image en octets (bytes)
Pour réutiliser ou partager son corpus
Si vous citez vos photos dans un document de recherche, vous pouvez avoir envie de les déposer dans un entrepôt de données (pour les partager, les réutiliser plus tard ou les archiver). Il convient alors d’adapter son modèle de saisie dans Tropy aux propriétés demandées ou disponibles dans l’entrepôt visé.
Exemple de Nakala
Nakala est l’entrepôt de données de HumaNum. Vos photos de recherche peuvent être considérées comme des données de recherche (surtout si vous les utilisez dans vos publications).
Huma-Num, dans la riche documentation de Nakala, a publié un Guide pour décrire ses données dans Nakala (Huma-Num, 2024).
Huma-Num a aussi publié une fiche pdf imprimable d’aide au dépôt dans Nakala (mars 2024).
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Créer un projet
[image: img/tropy-projet.png]
Menu: Fichier > Nouveau > Projet (Ctrl+Maj+P)
· Lui donner un nom
· Choisir le type (voir Lucchesi et al., 2023).
· Standard : Copie les photos dans le dossier du projet à l’import
· Advanced : Lien vers les photos sur votre disque (/!\)
· Choisir l’emplacement du projet sur son ordinateur
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	· Suggestion
· Dans le dossier Images par défaut, un sous-dossier Tropy, puis un sous-dossier par projet.


Les modèles de saisie
[image: IMG/tropy-template.png]
Préférences de Tropy > Modèles de saisie
Trois types d’objets dans Tropy
Donc trois types de modèles :
· Objet (Item) contient une ou plusieurs Photos
· Photo Contient zero, une ou plusieurs Sélections
· Sélection
Dans la documentation officielle
· Getting started with templates
Les modèles inclus dans Tropy
· Niveau item : Tropy Generic, Tropy Correspondance et Dublin Core
· Niveau photo : Tropy Photo
· Niveau selection : Tropy Selection
Ces modèles ne peuvent être supprimés ni effacés.
Créer ou personnaliser un modèle de saisie
Créer un modèle
Dans la fenêtre des préférence, onglets des modèles de saisie :
· Vider le champ Modèle de saisie
· Entrer un Nom (au choix)
· Choisir le Type (Objet, Photo ou Sélection)
· Renseigner le Créateur (Vous)
· Ajouter une petite Description
· Cliquer sur Créer
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Nouveau modèle
Ajouter des propriétés
[image: IMG/propriete.png]
Propriété
Personnaliser un modèle
· Cliquer sur l’icône Dupliquer
· [image: IMG/dupliquer.png]
· Dupliquer
· Ajouter, supprimer, déplacer, modifier les propriétés
Exemple du Projet Blot
· Template BlotPhotosV2.ttp : Télécharger
· Description dans le wiki du projet
Les extensions (Plugins)
[image: img/tropy-plugins.png]
Menu: Préférences… - Plugins
Table des extensions
	Nom (et lien)
	Description

	tropy-plugin-csl
	Tropy plugin to export your items to Zotero as CSL/JSON

	tropy-plugin-omeka
	This plugin can export selected items into an Omeka S instance.

	tropy-plugin-archive
	Tropy plugin for exporting items into a single zip archive. This includes all the metadata, as well as the photo files.

	tropy-plugin-csv
	Tropy plugin to import items from a CSV file, and export your items to CSV.

	tropy-plugin-iiif
	Download a IIIF manifest and select File > Import > tropy-plugin-iiif to start the import. The plugin tries to map the manifest’s metadata to standard metadata properties.


Importer des photos
Formats supportés
· JPG/JPEG
· PNG
· SVG
· TIFF
· GIF
· PDF
· JP2000
· WEBP
· HEIC
· AVIF
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	Attention
· Projet Standard
· Copie des fichiers dans le dossier du Projet
· Risque de doublon sur le disque dur (place)

· Projet Advanced
· Simple création d’une miniature et lien vers l’emplacement du fichier sur votre disque
· Risque de perte de données dans le projet si vous déplacez ou supprimez vos fichiers


Par le Menu Fichier
... > Fichier > Importer > Photos | Dossier
· Penser à définir le bon modèle d’import par défaut avant.
· [image: IMG/modeleDefaut.png]
· Préférences de Tropy > Paramètres
Par glisser-déposer
· De la fenêtre du dossier d’origine vers la fenêtre de Tropy (vue projet)
· Même recommandation (modèle d’import).
Par surveillance d’un dossier
· Menu édition:
· ... > Édition > Préférences...
· Onglet Projet -> Watch folder…
Par des plugins/extensions
CSV
1. Installer le plugin CSV
1. Menu: Edition > Préférences… | onglet Plugins -> Définir un profil d’import CSV
1. Menu: Fichier > Importer > Profil CSV : chemin du fichier .csv
IIIF
1. Installer le plugin IIIF
1. Menu: Edition > Préférences… | onglet Plugins -> Définir un profil d’import (modèle de saisie) IIIF dans les paramètres du plugin.
1. Télécharger un manifeste IIIF (souvent un fichier manifest.json) sur son ordinateur depuis un catalogue IIIF (Gallica, Biblissima, Europeana..)
· Liste de collections utilisant IIIF pour partager leurs ressources (IIIF Consortium, 2024)
1. Dans Tropy, Menu: Fichier > Importer > Profil IIIF : chemin du fichier manifest.json
Exporter (projet, photos, données)
Préférences > Export
Menu Exporter
· JSON-LD : LD pour Linked Data
· PDF
· Plugins
Plugins
· Archive : Photos et métadonnées dans un .zip
· CSV
· Omeka S
· CSL (Zotero)
Imprimer
Canaux officiels
· Documentation
· Support (forum)
· Vimeo
· Youtube
· X/Twitter
· GitHub (code source, templates…)
Tutoriels
Table des Tutoriels Tropy
	Auteur
	lien

	Benjamin Lailler
	Tutoriel Tropy (Laillier, 2019)

	Stretching numérique 2024
	Gérer ses photos d’archives avec Tropy (Leromain, 2024)

	Schlesinger Library on the History of Women in America - Harvard University
	Manage Research Images With Tropy (Fauxsmith, 2019)

	BULAC
	Gérer ses ressources iconographiques avec Tropy (Maisonneuve, 2024)

	Rennes 2
	Gérer ses photos de recherche avec Tropy (Croizet, 2024)


Vidéos
· Le 16 juin 2020, L’équipe de Tropy (Abby Mullen) a tenu un webinaire de type Tropy 101 [Youtube - 1h05]
· https://www.youtube.com/embed/jWjP90EWHkQ
· Tropy chanel : Metadata Templates in Tropy [Youtube - 10 mn]
· https://www.youtube.com/embed/Hk5APGD6200
· Projet EVEille : Séance d’initiation à Tropy, animée par Benoît Roux, juin 2021 [e-diffusion UHA - 1h28]
· https://e-diffusion.uha.fr/video/4023-initiation-a-tropy-avril-2021
· (Valmalle, 2021) Geneatech : Utiliser Tropy pour la gestion de ses photos d’archive [Youtube - 17 mn]
· https://www.youtube.com/embed/AiPqbdwP67E
Billets de blog
· Gérer ses photos d’archives avec Tropy - Franziska Heimburger - La boîte à outils des historien·ne·s (Heimburger, 2017)
· Tropy, un gestionnaire de photos d’archives pour les chercheurs - Florian Innocente, MacGeneration (Innocente, 2017)
· Six months of using Tropy - Emmanuel Mourlon-Druol (Mourlon-Druol, 2019)
· Tropy : un logiciel pour organiser des corpus iconographiques - Le Carreau de la BULAC (Larguèche, 2021)
· Personal image management software rec from an art historian: Tropy - Elizabeth Lee - The Digital Orientalist (Lee, 2021-03-16T)
· New Project Types in Tropy 1.13 - Tropy Blog (Lucchesi et al., 2023)
Produire des données FAIR
· Inspirés par le 5-Star Open Data proné par Tim-Berners Lee, mis en forme par Michael Hausenblas sur ce site : http://5stardata.info/fr/ [22 janvier 2012].
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	Les étapes 5-Star OpenData
Illustration des étapes 5-Star OpenData
	étoiles
	étape

	★
	Publiez vos données sur le Web (peu importe leur format) avec une licence ouverte

	★★
	Publiez-les en tant que données structurées (par exemple, un document Excel au lieu d’une image scannée d’un tableau)

	★★★
	Publiez-les dans un format ouvert et non-propriétaire (par exemple, un CSV plutôt qu’un Excel)

	★★★★
	Utilisez des URI pour désigner des choses dans vos données, afin que les gens puissent faire des références à celles-ci

	★★★★★
	liez vos données à d’autres données pour y ajouter du contexte




· Décrits ici, d’aprèsThe FAIR Guiding Principles for Scientific Data Management and Stewardship. DOI
The principles refer to three types of entities: data (or any digital object), metadata (information about that digital object), and infrastructure. For instance, principle F4 defines that both metadata and data are registered or indexed in a searchable resource (the infrastructure component).
Findable
The first step in (re)using data is to find them. Metadata and data should be easy to find for both humans and computers. Machine-readable metadata are essential for automatic discovery of datasets and services, so this is an essential component of the FAIRification process.
· F1. (Meta)data are assigned a globally unique and persistent identifier
· F2. Data are described with rich metadata (defined by R1 below)
· F3. Metadata clearly and explicitly include the identifier of the data they describe
· F4. (Meta)data are registered or indexed in a searchable resource
Accessible
Once the user finds the required data, she/he/they need to know how can they be accessed, possibly including authentication and authorisation.
· A1. (Meta)data are retrievable by their identifier using a standardised communications protocol
· A1.1 The protocol is open, free, and universally implementable
· A1.2 The protocol allows for an authentication and authorisation procedure, where necessary
· A2. Metadata are accessible, even when the data are no longer available
Interoperable
The data usually need to be integrated with other data. In addition, the data need to interoperate with applications or workflows for analysis, storage, and processing.
· I1. (Meta)data use a formal, accessible, shared, and broadly applicable language for knowledge representation.
· I2. (Meta)data use vocabularies that follow FAIR principles
· I3. (Meta)data include qualified references to other (meta)data
Reusable
The ultimate goal of FAIR is to optimise the reuse of data. To achieve this, metadata and data should be well-described so that they can be replicated and/or combined in different settings.
· R1. (Meta)data are richly described with a plurality of accurate and relevant attributes
· R1.1. (Meta)data are released with a clear and accessible data usage license
· R1.2. (Meta)data are associated with detailed provenance
· R1.3. (Meta)data meet domain-relevant community standards
Autour des standards IIIF
	
IIIF (International Image Interoperability Framework™) est un ensemble de standards qui définissent un cadre d’interopérabilité pour la diffusion des images numériques sur le Web.


IIIF permet la manipulation homogène d’images indépendamment de leurs localisations physiques et des établissements qui les hébergent. (utilisé notamment sur Europeana[footnoteRef:192] , Gallica[footnoteRef:194], Nakala, de nombreux serveurs Omeka…) [192:  Europeana IIIF APIs]  [194:  API IIIF de récupération des images de Gallica] 

· Une excellente documentation chez Biblissima.
· Une très large collection de ressources sur le GitHub du consortium : Awesome International Image Interoperability Framework (IIIF)
· La visionneuse Mirador
Importer dans Tropy des documents Gallica via le module IIIF
· API IIIF de récupération des images de Gallica :
· Base URL : gallica.bnf.fr/
· Manifest : iiif/{ark}/manifest.json
· Modèle : gallica.bnf.fr/iiif/ark:/XXXXX/manifest.json
· Exemples :
· gallica.bnf.fr/iiif/ark:/12148/bd6t538312611/manifest.json
· gallica.bnf.fr/iiif/ark:/12148/btv1b8451475v/manifest.json
Bonus
· Publier une image avec ses annotations : utilisation de Tesselle en histoire de l’art - Antoine Courtin (Numérique et recherche en histoire de l’art, 2020).
· Tesselle - médialab SciencesPo
· Avec des sources iiif : Adno
· Exemples
· Documentation
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Ce guide est mis à disposition des personnes qui déposent ou accompagnent au dépôt des données 
dans l’entrepôt NAKALA.


NAKALA est un entrepôt de données de recherche pour les sciences humaines et sociales. Son accès 
et son utilisation sont décrits dans la documentation d’Huma-Num:
https://documentation.huma-num.fr/nakala/


La qualité et la richesse de la description des données sont des critères centraux des principes FAIR. 
Cela constitue un moyen d’atteindre les objectifs visés (faire en sorte que les données soient faciles à 
trouver, accessibles, interopérables et réutilisables).


La qualité se met en œuvre, par exemple :


• en utilisant des référentiels standardisés;


• en respectant les mêmes normes intellectuelles de description pour un ensemble de données;


• en choisissant des champs de métadonnées les plus adaptés à l’information donnée.


La richesse se met en œuvre en complétant le plus grand nombre possible de champs afin d’optimiser 
la compréhension des données. Dans NAKALA, la description est basée sur un ensemble minimal de 
cinq informations qui peuvent être enrichies de manière étendue et cumulative. 


Ce guide propose un ensemble de conseils et bonnes pratiques pour les fichiers et les champs de 
métadonnées obligatoires et complémentaires de premier niveau.


Pour aller plus loin, un guide de description est disponible : 
https://documentation.huma-num.fr/nakala-guide-de-description/


Contact: nakala@huma-num.fr


SUIVI
Nom du déposant: 
Titre de la donnée: 
DOI: 
Suivi accompagné par: 
Date du suivi : 


Guide de dépôt


Critères Commentaires et propositions 
d’amélioration


Nommage


Il est recommandé d’établir un plan de nommage (préfixe commun pour tous les fichiers 
associés au projet) afin que les noms des fichiers soient cohérents et réguliers.
Remarque : pour un dépôt multifichiers, NAKALA permet de trier les fichiers par ordre alphabétique, 
après chargement.


Description


La description des fichiers peut être saisie: 
• pour des informations spécifiques à un fichier, dans le champ «Description» associé à chaque 


fichier.
Ces informations sont indexées par NAKALA et sont affichées dans la visionneuse.


• pour des informations globales sur l’organisation interne, le contenu, la définition des variables 
du ou des fichiers de la donnée, dans un document à part (type README, manifest IIIF, TEI-
header, métadonnées métier, METS, etc.).


Formats


NAKALA accepte tous les formats, mais quand c’est possible, privilégier un format ouvert 
compatible avec FACILE, le service de validation des formats: https://facile.cines.fr/


Pour les fichiers au format texte, l’encodage de caractères en UTF-8 est recommandé, si 
applicable.


La liste des formats supportés par l’API IMAGE IIIF dans NAKALA: «tif», «tiff», « jpg», « jpeg», 
« jp2», «png», «pdf», «geojp2».
Ces formats sont recommandés pour bénéficier des fonctionnalités du protocole IIIF.


Les fichiers
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Les métadonnées
Critères


Commentaires 
et propositions 
d’amélioration


M
ét
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 (o
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at
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re
s) Type de dépôt Vérifier que le type sélectionné est adapté à la donnée.


Remarque : dans le cas d’une donnée multifichiers, le type sélectionné rend compte du type principal de la donnée.


Titre
Renseigner un titre explicite et signifiant (comme le serait un titre d’article).
Remarque : si un titre non signifiant est nécessaire (identifiant ou nom de fichier), il peut être ajouté dans un second 
champ «Titre ».


Auteur


Vérifier que le nom des auteurs respecte la forme : Prénom Nom. 
Pour toutes autres formes d’auteurs, cocher «Anonyme» et les renseigner dans dcterms:creator
ou dcterms:contributor (zone «Ajouter d’autres métadonnées»).
Si l’auteur dispose d’un identifiant ORCID, renseigner cet identifiant.
Remarque : si l’auteur est déjà enregistré et que son ORCID n’est pas renseigné, demander la mise à jour en écrivant à 
nakala@huma-num.fr.


Cas d’un auteur dit 
«anonyme»


Vérifier s’il est possible de renseigner au moins une personne ayant participé à la production, à la collecte ou au 
traitement des données dans dcterms:creator ou dcterms:contributor (zone «Ajouter d’autres métadonnées»).
Remarque : les noms renseignés dans dcterms:creator s’affichent dans le bloc de citation.


Date de création


Renseigner la date de création de la source originale ou de la ressource numérique. Seuls les formats de date 
suivants sont possibles : YYYY-MM-AA (année-mois-jour), YYYY-MM (année-mois), YYYY (année).
Pour toutes autres formes de dates, cocher « Inconnue» et les renseigner dans dcterms:created
ou dcterms:date (zone «Ajouter d’autres métadonnées»).


Licence
La licence associée à la donnée est de préférence libre (Creative Commons, Etalab, GNU, etc.) et correspond 
aux droits de réutilisation possibles.
Remarque: vérifier ce qui justifie le recours à une licence non libre.


In
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ir


es Description
Décrire la donnée du point de vue scientifique : contexte de production et/ou de collecte ; méthodologie ; 
objectifs, etc.
Décrire le programme de recherche dans un autre champ «Description».


Résumé Saisir le résumé du projet dans dcterms:abstract (zone «Ajouter d’autres métadonnées»).


Table des matières Saisir une liste ou une table des matières dans dcterms:tableOfContents (zone «Ajouter d’autres 
métadonnées»).


Mots-clés


Renseigner au moins 2 à 3 mots-clés précisant le contenu intellectuel et le sujet de la donnée en français est 
fortement recommandé.
Le mot-clé doit être sous forme d’un mot, d’un groupe de mots ou d’une URI qui renvoie vers un référentiel de 
mots-clés.


Ajout de mots-clés dans 
une langue secondaire Si des mots-clés sont renseignés dans une autre langue, les renseigner dans un autre champ «Mots-clés».


Langues Pour des fichiers vidéo, son et texte, renseigner la ou les langue·s du contenu des fichiers.
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Métadonnées 
géospatiales
dcterms:spatial


Renseigner la couverture géographique du contenu intellectuel des données dans dcterms:spatial si pertinent.
Renseigner le positionnement hiérarchique de la localité est recommandé : «France, Auvergne-Rhône-Alpes, 
Rioupéroux».
Dupliquer le dcterms:spatial pour renseigner certains types d’informations spatiales normalisées :
• pour un concept issu du Thesaurus of Geographic Names (Getty Thesaurus of Geographic Names - TGN) : 


saisir l’identifiant du concept issu du TGN et sélectionner dans «Type» : dcterms:TGN.
• pour une zone géographique : saisir les informations de la zone géographique et sélectionner dans «Type» : 


dcterms:Box. 
Ex. Pour la zone géographique qui correspond à l’Australie occidentale, l’information doit respecter la forme 
suivante : name=Western Australia; northlimit=-13.5; southlimit=-35.5;westlimit=112.5; eastlimit=129.


• pour des coordonnées géographiques : saisir les coordonnées géographiques et sélectionner dans «Type» : 
dcterms:Point.
Les coordonnées géographiques doivent être saisies dans la forme suivante : name=Perth, W.A.; east=115.
85717; north=-31.95301.


• pour un code pays issu de la norme ISO3166 : saisir le code pays issu de ISO3166 (code Alpha-2) et sélectionner 
dans «Type» : dcterms:ISO3166.


Pour des précisions sur les formes à respecter lors de l’utilisation des «Types», se référer au guide de description :
https://documentation.huma-num.fr/nakala-guide-de-description/


Métadonnées 
temporelles
dcterms:temporal


Renseigner la couverture temporelle du contenu intellectuel des données dans dcterms:temporal.
Si l’information est sous la forme d’une période (temporelle ou historique) avec un intervalle temporel délimité, 
sélectionner dans «Type» : dcterms:Period. 
L’information doit respecter la forme suivante : «name=Haut empire Romain; start=-0030; end=0099» ; saisir 
quatre chiffres est obligatoire pour renseigner les années ; l’année «start» doit être antérieure à l’année «end».
Pour des précisions sur les formes à respecter lors de l’utilisation des «Types», se référer au guide de description :
https://documentation.huma-num.fr/nakala-guide-de-description/


Lien vers la publication
dcterms:
bibliographicCitation
et/ ou 
dcterms:isReferencedBy


Si une publication est associée aux données, il est fortement recommandé de l’indiquer .
Renseigner la référence bibliographique complète dans dcterms:bibliographicCitation (vérifier que l’identifiant 
pérenne de la publication est renseigné ou l’ajouter, si applicable).
Saisir l’identifiant pérenne de la publication dans dcterms:isReferencedBy, si applicable.
Aucune information de langue ne doit être saisie.


Droits
dcterms:rights


Si un embargo sur un ou des fichiers a été apposé, il est recommandé d’en préciser la raison dans un 
dcterms:rights.


Éditeur
dcterms:publisher


Saisir le nom du responsable de la mise à disposition de la ressource dans dcterms:publisher (le nom du 
laboratoire dans sa forme actuelle, par exemple).


Relation vers des 
ressources externes:
données hors NAKALA, 
base de données, etc.
dcterms:relation


Si des données déposées dans d’autres entrepôts (projet interdiscplinaire) ou dans des ressources sur le web 
(base de données, sites, bibliothèques numériques, etc.) sont en lien avec la donnée, il est recommandé de les 
indiquer dans dcterms:relation.
Saisir l’identifiant pérenne de la ressource externe à mettre en relation.
Lorsqu’une URI est renseignée, sélectionner dans le champ «Type» dcterms:URI.
Aucune information de langue ne doit être saisie.


Remarques
Il est fortement recommandé de préciser la langue de chaque métadonnée renseignée sous forme textuelle.
Si vous avez uniquement renseigné une URI dans une métadonnée, sélectionner dans le champ «Type» dcterms:URI et ne surtout pas renseigner d’information de 
langue.
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